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USER GUIDE

SCC-FV01 Frequency Input
Module

The SCC-FVO01 frequency input module is a frequency-to-voltage
converter designed to measure signals from frequency-generating sensors
and other periodic signal sources. The DC output voltage of the module is
proportional to the input frequency.

Conventions

The following conventions are used in this guide:

<> Angle brackets that contain numbers separated by an ellipsis represent a
range of values associated with a bit or signal name—for example,
P1.<3..0>.

» The » symbol leads you through nested menu items and dialog box options

to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

> @

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

é When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.

ii When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select in software, such as menu
items and dialog box options. Bold text also denotes parameter names.
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italic

monospace

SC-2345

SCC

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

SC-2345 refers to both the SC-2345 connector block and the SC-2345
configurable connector.

SCC refers to any SCC Series signal conditioning module.

What You Need to Get Started

To set up and use the SCC-FVO01, you need the following items:

U SC-2345/2350 with one of the following:
—  SCC-PWRO1
—  SCC-PWRO02 and the PSO1 power supply

—  SCC-PWRO03—requires a 7 to 42 VDC power supply
(not included)

One or more SCC-FV01

SCC-FVO0I Frequency Input Module User Guide
SC-2345/2350 User Manual, available at ni . com

SCC Quick Start Guide, available at ni . com

Read Me First: Safety and Radio-Frequency Interference
SC-2345 Quick Reference Label

68-pin E Series DAQ device, documentation, and 68-pin cable
1/8 in. flathead screwdriver

Numbers 1 and 2 Phillips-head screwdrivers

Wire insulation strippers

(I NI U U U I NI N MU MU W

NI-DAQ (current version) for Windows 2000/N'T/XP/Me

SCC-FV01 Frequency Input Module User Guide 2 ni.com



@ Note Software scaling of measurements is not supported on the Macintosh operating
system. Refer to the SCC-FVOI Module Pin Assignments section for more information.

Device Specific Information

@ Note For general SCC module installation and signal connection information, and
information about the SC-2350 carrier, refer to the SCC Quick Start Guide, available for
download at ni.com/manuals.

Installing the Module

Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

You can plug the SCC-FV01 into any analog input socket on the SC-2345.
It can function as a single-stage analog input or as the second stage of a
dual-stage analog input configuration. The socket you choose determines
which E Series DAQ device channels receive the SCC-FVO01 signals, as
explained in the Connecting the Input Signals section.

For single-stage input conditioning, plug the SCC-FV01 into any socket
J(X+1), where X is 0 to 7, and connect the input-signal wires to the module
as described in the Connecting the Input Signals section.

@ Note If you use the SCC-FVO01 in a dual-stage configuration, you must use it as the second
stage. Plug the first-stage module into any socket J(X+9) and plug the SCC-FVO01 into
socket J(X+1), where X is O to 7.

Sockets J9 to J16 are also available for digital input/output conditioning
or control. Refer to the SC-2345 User Manual for more information on
configuring, connecting, and installing SCC modules.

Connecting the Input Signals

@ Note The signal names have changed. Refer to ni.com/info and enter rdtntg to
confirm the signal names.

1 Each screw terminal is labeled by pin number <1..4>. The SCC-FVO01
has two referenced single-ended (RSE) input channels. Pins 1 and 2
form a channel routed to E Series DAQ device channel X+8, and pins
3 and 4 form a second channel routed to E Series DAQ device channel
X. The value of X is determined by the number of the SC-2345 socket
where you plug in the module, J(X+1) or J(X49). Both input channels
are referenced to Al GND of the E Series DAQ device.

© National Instruments Corporation 3 SCC-FV01 Frequency Input Module User Guide



@ Note If your application requires nonreferenced inputs, consider using an SCC-AI Series
module as the first stage in a dual-stage configuration.

For information about how to configure the SCC-FV01 module using
NI-DAQmx, refer to the SCC Quick Start Guide.

Using the SCC-FV01

Scaling Voltage Measurements

If you configured the SCC-FVO01 using Measurement & Automation
Explorer (MAX) and you are using NI-DAQ, the reading you get from the
E Series DAQ device is properly scaled. Otherwise, you must scale your
readings by multiplying the measured DC voltage by 10 to get the input
frequency in hertz.

Measuring Frequencies Below 5 Hz

The output ripple of the SCC-FVO01 increases as the input frequency
decreases, and it is significant for frequencies below 5 Hz. To overcome the
effect of output ripple, acquire and average at least 100 samples per period
for two periods of the input frequency. This gives you more accurate
measurements of frequencies below 5 Hz with the exception of 0 Hz.

At 0 Hz there is no ripple; therefore, there is no special need to acquire
and average your data.

Calibrating Offset Errors

The SCC-FV01 module is calibrated at the factory before shipment. If you
want to adjust for any errors in your system, you need a function generator
and an oscilloscope capable of measuring the frequency you are applying.
The oscilloscope must be several times more accurate than the SCC-FVO01
itself.

To adjust the SCC-FV01 module, complete the following steps:

1. Connect the function generator and oscilloscope to the input of the
specific SCC-FVO01 channel you are calibrating.

2. Adjust the function generator to output the maximum frequency and
amplitude you are measuring.

3. Using your software, have the E Series DAQ device read the
SCC-FVO01 channel.

4. Adjust the potentiometer on top of the SCC-FVO01 module that
corresponds to the channel you are calibrating. Turn the potentiometer
until your software measures the same frequency as that measured by
the oscilloscope at the input.

SCC-FV01 Frequency Input Module User Guide 4 ni.com



Specifications

These ratings are typical at 25 °C unless otherwise stated.

Input Characteristics

Number of input channels

Input signal amplitude.............c........

Input coupling
Minimum input frequency
Maximum input frequency

Minimum input pulse width

(5 V pulse train) ........coeeeeeeevereenennnne

Input impedance

Signal = threshold (0 V)..............
Signal < threshold (0 V)..............

Threshold

Hysteresis

Transfer Characteristics

Output response time following
a full-scale input change

Output offset

Output offset temperature coefficient ....

GalN €ITOT ..o

Gain error temperature coefficient

Nonlinearity ......ccoccoeeveerervenieneeneene.

I Recommended; minimum =100 mV.

© National Instruments Corporation

+200 mV!to 10 V
(zero crossing)

DC

0 Hz

100 Hz

1.5 us

400 kQ
10 MQ

ov

200 mV

80 ms at 63%
220 ms at 90%
360 ms at 99%

.... 5 mV max
10 ppm/°C
.... 10.1% max
100 ppm/°C

... 0.015% full-scale

SCC-FV01 Frequency Input Module User Guide



Output 1ipple..cc.eeeeeeniieieeieeieeeeeeee 30 mV,at 10 Hz
(input signal frequency)

Output Tange ........ccceeveeveereeeeneeceeneennn. 0to+10 V (NRSE)

Recommended warm-up time................. 5 min

Power Requirements

ANalog POWET .....eeveeeruiiiiiieieiieenieeieene 100 mW
FIS Vo 4.9 mA
ISV e 1.75 mA

Digital POWET ....cc.ooeeverieiiniiiienieeieee 0 mW
TSV e 0 mA

Operating voltage accuracy requirements

FISV e +10%
15V e +10%
REFS5V ..o 10.05%
Physical
Dimensions .........cooevuveeeeveiiieeeeeiiiieeeeeenns 8.89cm x2.92 cm x 1.85 cm

(3.5in. x 1.15 in. x 0.73 in.)

I/0 connectors.......c.cceueecveeueecveneenieneenns One 20-pin right-angle male
connector,
one 4-pin screw terminal
(detachable)

Wire gauge range...........cccceeeeceeneeiennenne 28to 16 AWG

Maximum Working Voltage

Maximum working voltage refers to the signal voltage plus the
common-mode voltage.

Channel-to-earth .........ccccceevveencrnencnnncns +10 V, Installation Category I

Channel-to-channel............ccccocceeenennen. +10 V, Installation Category I

SCC-FV01 Frequency Input Module User Guide 6 ni.com



Environmental

Operating temperature..............ceerveennnenn 0to 50 °C

Storage temperature .............cccceeeeeennene —20to 70 °C

Humidity ..ooooovevenieieiiieieenencee 10 to 90% RH, noncondensing
Maximum altitude ..........ccceevvvevivininnnnnn. 2,000 meters

Pollution Degree (indoor use only)........ 2

Safety

The SCC-FVO01 meets the requirements of the following standards
for safety and electrical equipment for measurement, control, and
laboratory use:

e IEC61010-1, EN 61010-1
e UL3111-1, UL 61010B-1
« CAN/CSA C22.2 No. 1010.1

@ Note For UL and other safety certifications, refer to the product level, or visit
ni.com/hardref .nsf, search by model number or product line, and click the
appropriate link in the Certification column.

Electromagnetic Compatibility

Emissions .......ccoovveeeeeviinveeeeeiiineeee e, EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz

IMMUNIEY .o EN 61326:1997 + A2:2001,
Table 1

CE, C-Tick, and FCC Part 15 (Class A) Compliant

@ Note For EMC compliance, operate this device with shielded cabling.

CE Compliance

This product meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety) ............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMOC) .....c.ooooovviieiiiieieeeien, 89/336/EEC

© National Instruments Corporation 7 SCC-FV01 Frequency Input Module User Guide
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Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/hardref.nsf, search by model number or product line, and click the
appropriate link in the Certification column.

SCC-FV01 Module Pin Assignments

Figure 1 shows the I/O connector pins on the bottom of the module.

/@

000000000
Q000000000 @
A .4

1 Pin1 2 Pin2 3 PWB Key 4 Pin19 5 Pin20

Figure 1. SCC Module Bottom View
Table 1 lists the signal corresponding to each pin.

Table 1. SCC-FVO01 Pin Signal Assignments

Pin Number Signal

1 E Series Al (X)
2 E Series AI GND
3 —

4 E Series AI (X+8)
5 —

6 E Series Al GND
7 —

8 E Series AI GND

SCC-FV01 Frequency Input Module User Guide 8 ni.com



Table 1. SCC-FVO01 Pin Signal Assignments (Continued)

Pin Number Signal
9 —
10 —
11 A GND
12 REF5V
13 +15V
14 -15V
15 —
16 —
17 AI (X)—(from first stage)
18 Al (X+8)+(from first stage)
19 Al (X)+(from first stage)
20 Al (X+8)—(from first stage)

Al (X) and AI (X+8) are the analog input signal channels of the E Series
DAQ device. AI GND is the analog input ground signal and is the reference
for Al (X) and AI (X+8). A GND is the reference for the 15 V supplies and
REF 5 V. AT GND and A GND connect to the SC-2345 at the SCC-PWR
connector. Pins 17 to 20 accept inputs from a first-stage SCC module if you

are cascading two modules.

© National Instruments Corporation
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Theory of Operation

Figure 2 illustrates the key functional components of the SCC-FVOI.

Signal
Source

m
o

m
=)

Comparator

m
=

m
=

Comparator

Triggering
Stage

Frequency- : : 3 Hz |
to-Voltage [ || Buttlt__ai:;/:/scrnrth e
Frequency- : : 3 Hz :
to-Voltage | : 1| Buttlt__ain/‘vacrarth T
F-v Output
Stage Stage

Al (X)

Al SENSE
Al GND

Al (X+8)

Figure 2. SCC-FV01 Signal Connections

The SCC-FVO01 has two input channels designed to measure 0 to 100 Hz
signals. The output voltage (0 to 10 VDC) varies linearly with respect to the

input frequency.

The frequency-to-voltage and analog circuitry for each channel consists of

a triggering stage, a frequency-to-voltage stage, and an output stage.

SCC-FV01 Frequency Input Module User Guide
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Refer to Figure 3 as you read the following sections.

Input Signal
f=90 Hz
Threshold =0V
Hysteresis = 200 mV

Triggering Stage

Pulse Generator

Filtered Output

+100 mV ';;_-,Am‘-\-\\----
ov

-100mV ----

[P A S P

:
Q.

5V

o
<

5V
ov

9V
oV

Tyttt =—/o" """~

I s R

Triggering Stage

Figure 3. Input Channel Stages

This stage consists of a trigger circuit that compares the input waveform to
a fixed threshold and hysteresis to create a square-shaped pulse for the next
stage.

The purpose of hysteresis is to reduce the number of false triggers caused
by noise. In order to be measured and trigger the pulse generator, the
amplitude of the input signal must exceed Vygresnorn T 1/2 Vaysreresiss
and both the maximum and the minimum peaks must lie outside the
hysteresis range. The threshold for the SCC-FVO0L is fixed at 0 V and the
hysteresis is fixed at 200 mV. This means the amplitude of the input signal
must be at least £100 mV , and the peaks must lie on each side of the
+100 mV hysteresis range in order for the signal to be measured (refer to
the first section of Figure 3). To ensure maximum accuracy, use an input
signal of amplitude 200 mV, (400 mV,,_)) or greater.

@ Note Input signals that do not pass through 0 V, such as digital pulse trains, do not meet
the triggering requirements and cannot be measured.

The maximum input range is £10 V. You can extend the input range

by using an analog input module as the first stage of a dual-stage
configuration. For example, the SCC-AI02 module has a gain of 0.5

and isolation. If you use an SCC-AI02 as the first stage, you increase the

© National Instruments Corporation 11 SCC-FVO01 Frequency Input Module User Guide



effective input range from =10 V to £20 V, and you increase the hysteresis
range from £100 mV to 2200 mV. The SCC-AI02 module also provides
isolation between the input signal and the DAQ device.

Frequency-to-Voltage Conversion Stage
This stage consists of the following:
e A pulse generator that produces one pulse per input cycle

* A charge pump stage that uses capacitors to convert the pulse
frequency to a proportional output voltage

Output Stage

This stage consists of a 3 Hz lowpass Butterworth filter, which averages
the output of the frequency-to-voltage conversion stage and produces a
DC voltage equal to 0.1 times the input frequency.

National Instruments™, NI™, ni.com™, and NI-DAQ™ are trademarks of National Instruments

Corporation. Product and company names mentioned herein are trademarks or trade names of their

respective companies. For patents covering National Instruments products, refer to the appropriate

location: Help»Patents in your software, the patents. txt file on your CD, orni . com/patents. 371069B-01 Mar04
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